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1 Introduction

1.1 Overview

As part of the Akrometrix Studio software platform, Surface Measurement is
designed as the data acquisition package for any Akrometrix hardware utilizing the
shadow moiré, fringe projection, or DIC techniques. It features a multiple document
interface where the user interacts with child windows and context menus allowing many
types of information to be displayed and compared on screen at one time.

This manual describes the interface and functions of the Surface Measurement
software. Automated data acquisition during a thermal profile is described in the
Thermal Profiler User Manual and analysis is described in the Surface Analysis User
Manual. Surface Measurement requires system hardware to operate and, thus, will only
be installed on computers attached to Akrometrix measurement equipment. Surface
Analysis may reside on the measurement equipment computer and/or on a remote
computer.

A user unfamiliar with shadow moiré, fringe projection, and DIC and their application
in Akrometrix measurement systems is advised to first read Akrometrix Techniques
and Analysis 101.

Section 2 describes the program interface and its functions. Section 3 describes
the program functionality while in MP10 mode. Section 4 describes the program
functionality while in DIC mode. Section 5 describes common problems and
troubleshooting. Appendix A describes software file formats and keyboard shortcuts.

1.1 Warnings and Notes

1.1.1 Warnings and Notes in this Manual
Warnings and Notes are marked throughout the manual with these icons:

®

Figure 1.1 Warning Icon Figure 1.2 Note Icon

L

il

Warnings are specific health hazards for the operator or potential sources of system
damage. Notes highlight system limitations or automatic responses that may require
corrective action by the operator for successful operation.

1.2 Technical Support

For technical support, contact Akrometrix:
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Akrometrix 404-486-0880 support@akrometrix.com
2700 NE Expressway 404-486-0890 (fax) http://www.akrometrix.com
Building B, Suite 500

Atlanta, GA 30345

When contacting Akrometrix, please provide the system serial number, the version
numbers of the Akrometrix software being used, a description of the problem or
guestion, and contact information for reply. If the question concerns a particular
measurement or analysis, please provide electronic copies of the phase images,
reference images, and final results and a description of data acquisition and/or analysis
conditions. If the problem concerns changes or failure in general system operation,
please describe any events or system modifications that occurred immediately before
the problem arose.
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2.1

2.2

2 Surface Measurement

Start-up

. Run Surface Measurement by clicking the Surface Measurement button in the

Studio Manager bar on the left side of the screen. Alternatively, the program can
be run from the desktop shortcut or by pointing to Start->All
Programs—>Akrometrix->Surface Measurement. A start-up splash screen
appears while the software initializes.

. When asked whether or not to home the grating stage, ensure that all

obstructions are removed from the stage path and press Yes. If No is pressed,
the application will quit.

. The main Surface Measurement screen will display. The parent window contains

a camera view and all other windows that the program spawns.

Acquiring Data

. Position the sample under the grating, using the Camera window (see Figure

2.1) to line up edges of the part so that they are more or less parallel with the
edges of the camera view.

. Adjust the region of interest, or ROI, such that it fully encompasses the part to be

measured.

. Adjust the sample/grating height using the Sample Height Adjust Window (see

Figure 2.2) so that there is adequate fringe contrast on the sample. It may also
be necessary to adjust the camera iris settings to get adequate brightness on the
sample. Use the highlight saturated and dark pixels options to avoid getting
saturation in the fringe image. These can be activated by going to the Camera
Control window described in Section 2.3.2.
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Camera Sample Height D

Jog Speed
Fast b

Jog Up

Jog Down

Position {mils)

213

(*) Absolute
() Relative

Figure 2.2 Sample Height
Adjust Window

Figure 2.1 Camera Window, Information Bar Circled

4. Right-click on the Camera window (inside the ROI) to bring up a context menu
(see Figure 2.9) that contains the Acquire... command. Click Acquire... or,
alternatively, press the F12 key.

2.3 Information Bar

At the bottom of the Camera window (see Figure 2.1), an information bar displays
relevant acquisition parameters for quick user reference. These include

e which grating is selected (if more than one is installed on the system)
e the camera iris setting

e the phase amplitude

e the ROI location and size, in pixels

Each one of these parameters can be edited by clicking on the desired parameter.
See the following sections for a brief description of each parameter and how it can be
edited.

2.3.1 Grating

The grating parameter area has an arrow on the right side. When clicked, it opens a
window containing the calibration routines for a grating as well as a grating editor
screen. See Section 2.8 for instructions on using the calibration routines.

When more than one grating is installed on the system, clicking directly on the
grating information area brings up a grating selection menu. The user can select among
the available gratings to be the active grating.
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Calibrate DAQ Fringe Height
Calibrate Fringe Value
Edit Parameters. ..

Grating: 100 Ipi ~ | Camera Iris: 24% | Phase

Figure 2.3 Grating Pop-Up Menu

Edit Grating - 100 Ipi (/N 123456)
Compensation
Area

Width (in) Height i}

000 (&) oo =

DAQ Fringe Height {mils)
267236 2] Coefficients
Constant 000000 13
x |0.00000 :::
Fringe Value {mils)

05921 |2 L e
X 000000 [
x2 |0.00000 :3:
y2 [noooo0

Figure 2.4 Edit Grating Window

Select Grating
Frequency lpi)  Serial Mumber  DAQ Fringe Height (mils)  Fringe Value {mils)
100 123456 1267236 9.599212
300 654321 3.333333 3333333
QK Cancel

Figure 2.5 Select Grating Menu

2.3.2 Camera lris

To the right of the Grating Parameters section is the Camera Iris setting. This area

shows the current camera iris setting in per

centage form. A Camera Control dialog can

be opened by clicking on the Window menu at the top of the main screen. This dialog
can control the camera iris setting as well as turn on and off highlighting of dark or

saturated pixels.

Camera Control

|

Highlight Pixels

Dark

Irig (%)

24

Saturated

[4]¥]

Figure 2.6 Came

ra Control Window

Page 8 of 35

30-50SW-0002 Rev. A



Y akrometrix

Surface Measurement User Manual

2.3.3 Phase Amplitude

This section displays whether or not Phase Amplitude Thresholding is turned on,
and, if so, what its value is set to. Again, this parameter can be edited by clicking on the
phase amplitude area to open a setting dialog.

Phase Amplitude

Enabled

Threshold
30 =

-

Figure 2.7 Phase Amplitude Adjustment Window

2.3.4 ROI Location

This section describes where in the field of view the ROI, or region of interest, is
located and what its size is in pixels. Clicking on this area brings up a dialog that allows
precise adjustment of the position and size of the ROI.

Region Of Interest

Region of Interest
X Y Width Height
bet [ 400 = (207 & 203 =

[ 0K l [ Cancel

Figure 2.8 ROI Adjustment Window

The ROI can also be adjusted using the following keyboard shortcuts when it has
focus. Shifting can be done using the arrow keys or the outer number keys located on
the NumPad. Each press of a key results in one pixel shift of the ROI.

For example:
Up Arrow or 8 on NumPad Move ROI up one pixel
7 on NumPad Move ROI up one pixel and left one pixel

Holding down Ctrl while pressing any of these keys will now increase the ROI size
in the desired direction. Ctrl+5 will make the ROI its maximum size. Holding down Alt
while pressing any of these keys will decrease the ROI size in the desired direction.
Alt+5 will make the ROI half of the maximum length and width and position it in the
center of the field of view.
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2.4 Camera Window Context Menu

There are several different commands that can be issued when interacting with the
Camera window in Surface Measurement. These commands can be accessed by right-
clicking within the Camera window and include:

e Acquire... F12
e Shrink To Fit
e FillROI... F3

e Export Full Field Image...
e Open Thermal Profiler... Ctrl+T
The acquire command will only be available if the user right-clicks inside of the ROI.

Acguire... F12
Shrink To Fit

Fill ROI F3

Export Full Field Image. ..

Open Thermal Profiler. ..

Figure 2.9 Camera Window Context Menu

2.4.1 Acquire
The Acquire command performs a onetime phase image capture.

2.4.2 Shrink To Fit
If checked, the camera image is forced to the window size.

2.4.3 Fill ROI

Toggles whether or not the region of interest appears as a transparent square or as
a square outline.

2.4.4 Export Full Field Image

This command will perform an export of exactly what the user sees within the
Camera window, ROI included. The following image export formats are supported:
.bmp, .gif, .jpg, .png, and tif.

2.4.5 Open Thermal Profiler

This command opens a separate application in the Studio Suite called Thermal
Profiler. This allows automated data capture while subjecting the sample to a thermal
profile. For more details please see the Thermal Profiler User Manual.
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2.5 Phase Image Context Menu

There are several different commands that can be issued when interacting with a
Phase Image in Surface Measurement. These commands can be accessed by right-
clicking within the Phase Image window and include:

e Save... Ctrl+S
e Save Image... Ctrl+l
e Open in Surface Analysis... Ctrl+O

e Properties...

2.5.1 Save

Saves the phase image as a *.akx_phase file which can be analyzed using Surface
Analysis. The phase image name is constructed from the date and time at acquisition,
but can be changed by the user.

2.5.2 Savelmage
Saves the phase image as either a *.bmp or *.jpg image file.

2.5.3 Open in Surface Analysis
Opens the phase image in the Surface Analysis application.

2.5.4 Properties
Views phase image properties in a separate window.

2.6 3D Surface Image Context Menu

There are several different commands that can be issued when interacting with a
3D Surface Image in Surface Measurement. These commands can be accessed by
right-clicking within the 3D Surface window and include:

e Scale Z-Axis...

e Save...

e Save Image...

e Copy View Ctrl+C
e Paste View Ctrl+Vv
e Print...

e Create Legend...

o Properties...
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2.6.1 Scale Z-Axis

Allows the user to scale the Z axis of the graph and change the display units as
well.

2.6.2 Save

Saves the 3D surface in one of the following data formats: *.akx_disp, *.dat, *.txt, or
*.bin. Only the *.akx_disp file can be loaded back into Surface Analysis.

2.6.3 Save lmage
Saves the phase image as either a *.bmp or *.jpg image file.

2.6.4 Copy View

Copies the current 3D Surface Image view parameters (Rotation, Altitude, and
Zoom) so that they can be applied (pasted) to another 3D Surface Image.

2.6.5 Paste View

This command is only available if the user has a copied a 3D view to the clipboard.
If it is available, it pastes a copied view from the clipboard onto a 3D Surface Image.

2.6.6 Print
Prints a 3D Surface Image.

2.6.7 Create Legend
Allows the user to select the min and max for and create a legend image.

2.6.8 Properties
Views 3D Surface Image properties in a separate window.

2.7 File Menu Bar

At the top of the Surface Measurement application window there is a standard
Windows File Menu bar (see Figure 2.10). It contains the following menu categories:

e File

e Tools

e Window
e Help

2.7.1 File

The File menu will change depending on what type of window has focus. It will have
relevant commands for the currently selected window type. For example, if the Camera
window is selected, it contains an Acquire command, a Save Full Field Image command
and an Exit command.
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File | Tools  Window  Help

Acguire... Fi2
Export Full Field Image. ..

Exit
Figure 2.10 File Menu

2.7.2 Tools

The tools drop down menu contains four items. The first, a grating manager, allows
the user to add or remove gratings from the system. The second opens the Thermal
Profiler app. The third allows the user to check the measurement accuracy of a normal

step height block (see Section 2.8.3). The last selection opens system options as
described in Section 2.9.

Tools | Window  Help
| Manage Gratings 3 Add...
{&| Thermal Profiler... Cirl+T Remove...
Accuracy Chedk
Options. ..

Figure 2.11 Tools Menu
2.7.3 Window

This menu item contains commands for managing the child windows that are
present within the parent Surface Measurement window at any time. Windows that may
be hidden behind other windows can be brought to the foreground by selecting them in
this drop down menu. All open windows can also be closed by selecting the Close All
Windows command. The Camera (Section 2.2), Sample Height (Section 2.2), and
Camera Control (Section 2.3.2) windows are always available in this menu.

Window | Help

Close All Windows Ctrl+shift+w
Camera F5
Sample Height Fa
Camera Contraol F7

1 2008-10-27 12h21m29=* {Composite)
2 2008-10-27 12h21m29s*
3 2008-10-27 12h21m29s

B EE S erm |

Figure 2.12 Window Menu
2.7.4 Help

This menu item contains a link to the Surface Measurement User Manual as well
as an About command for determining program version information.
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2.8 Grating Calibration Routines

The grating calibration routines can be accessed by clicking the small arrow to the
right of the Grating information area on the Information bar (see Figure 2.13). Clicking
on either one of these items will put the system in the respective calibration mode. The
user must deselect the calibration mode when calibration is complete.

Calibrate DAQ Fringe Height
Calibrate Fringe Value
Edit Parameters...

Grating: 100 Ipi ~| Camera Iris: 24% | Phast

Figure 2.13 Grating Pop-Up Menu

2.8.1 DAQ Fringe Height

In the Calibrate DAQ Fringe Height mode, a uniform white colored continuous
surface sample is used to determine the optimal phase step distance based on the
optical configuration of the system. The calibration sample is provided by the user and
can be any white colored, continuous surface sample that is at least 100mm x 100mm.
The sample must also be sufficiently stiff so as to maintain its shape while phase
stepping occurs.

1. When Calibrate DAQ Fringe Height mode is enabled the ROI bounding box
becomes a dashed outline.

2. After placing a uniform white colored continuous sample in the measurement
system, adjust the ROI such that it only encompasses a continuous part of the
sample.

3. Right click to select Start Calibration... from the Camera window context menu.
A series of images is taken with different step heights to determine the best
calibrated phase step distance, or DAQ Fringe Height. While the images are
being taken a dialog (see Figure 2.14) pops up showing the captured images
and a plot of the intensity standard deviation for each step height trial.
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-

a) DAQ Fringe Height Calibration 2008-09-16 12h51m54s =
5mils | 6mils | 7mils | 8mis | Smils | 10mils | 11 mis | 12 mils | 13 mils | 14 mils | 15 mils | Plotted Data
14 T T T T T T T T T T T

4 - 121018 7

Brightness Standard Deviation

—tt
4 6 8 10 12 14 16
DAQ Fringe Height (mils)

Grating: 100 Ipi | Camera Iris: 24% | ROI Location: 536, 400 Size: 207, 203

Figure 2.14 DAQ Fringe Height Cal Dialog

4. At the completion of the calibration routine a dialog pops up asking the user to
update the DAQ Fringe Height.

5. Press Yes to approve and save the new DAQ Fringe Height. If an error is
suspected (refer to Section 5.1), press No to discard the new calibration value.

2.8.2 Fringe Value

In the Calibrate Fringe Value mode, a single step calibration block is used to
determine the Fringe Value calibration constant for the system. This block is provided
with the measurement system. See Akrometrix Techniques and Analyses 101 for
more details on this calibration constant.

1. Enter the calibration offset value in the Calibrate Fringe Value dialog box that
pops up and click OK. The calibration offset value for the block is on the
Calibration Certificate provided with each block.

2. Adjust the ROI such that the outside square approximately outlines the
calibration block. Exact alignment is not required because measurements are
made only within the inner two rectangles, which are inset from the outside
boundary.

3. Right click within the ROI and click Start Calibration... The calibration process is
initiated and three windows pop up afterward. These windows show the phase
image, the displacement data, and a Confirm Calibration Results dialog.

4. Press Yes to approve and save the new Fringe Value. If an error is suspected
(refer to Section 5.1), press No to discard the new calibration value.
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2.8.3 Accuracy Check

Under the Tools menu at the top of the program there is an Accuracy Check
function, which is used for checking the normal height between two surfaces. This is
useful for checking system accuracy against a cal block with a machined step height in
it. Typically, the accuracy check measurement is compared with that of a CMM or laser
based profilometer measurement.

2.9 Software Options

Surface Measurement options can be accessed by going to Tools — Options. A
Dialog appears as in Figure 2.15.

= Options
B Acquisition
Delay Per Step (ms) 150
Surface Units microns
B Sample Motion
Position Units microns
B Window Management
ClozeAllWindowsOnAcquire False| A
FullFieldCompaosite Window False
PhaseWindow True
Surface Window True
QK ] [ Cancel

Figure 2.15 Options Dialog

2.9.1 Delay per Step

Determines the amount of time in milliseconds the software waits between each
phase step. Increasing this value can be useful for samples that exhibit excessive
vibration between each phase step. Keep in mind, however, that increasing this value
will increase total data acquisition time.

2.9.2 Surface Units

Determines what units the Surface Windows display in. Options are mils or microns.

2.9.3 Position Units

Determines what units the Sample Height dialog displays the current motor travel
position in. Options are mils or microns.
2.9.4 Close All Windows on Acquire

On Acquire, closes all open phase images and surface windows within the Surface
Measurement parent window. Setting this to false will spawn a new phase image
window and/or displacement window on each Acquire.
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2.9.5 Full Field Composite Window

On Acquire, displays a window showing the entire camera FOV with the phase data
overlaid on top.

2.9.6 Phase Window
On Acquire, displays a window showing the phase image captured.

2.9.7 Surface Window

On Acquire, displays a window showing the 3D surface calculated from the
captured phase image.

30-50SW-0002 Rev. A Page 17 of 35
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3 MP10 Surface Measurement

The interface and operation of the MP10 Surface Measurement program are very
similar to the Surface Measurement program. A user unfamiliar with the Surface
Measurement software should read Section 2 first or refer to it where necessary for
operation of the MP10 software. In this section, only MP10 specific functions will be
described.

In the MP10 module, a new grating located at the projection path needs to be
controlled for phase shifting. Therefore, in the MP10 software, there are some additional
functions for homing and moving this grating stage.

——  Note: The AXP sample height adjustment stage is still
—-| inuse. Instead of executing phase shifting, it is used to
move the sample vertically for focusing purposes.

3.1 Start-up
1. Remove the TherMoiré grating from the oven lid if it is in place.
2. Install the MP10 module. (Refer to the MP10 Module User Manual).

3. Run the MP10 Surface Measurement program by clicking the corresponding
button on the Akrometrix Studio Manager toolbar on the left side of the screen. A
start-up splash screen appears while the software initializes.

4. When the Homing Sequence Confirmation Dialog is displayed (Figure 3.1),
press Yes to continue program initialization. Both the TherMoiré and MP10
stages will home.

¥ akrometrix

MP 10 SURFACE MEASUREMENT

1 Homing Sequence Confirmation ' ‘

‘__? / Both motion systems will home. Continue?

[ Yes ] [ No ]

Figure 3.1 Homing Sequence Confirmation
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5. The main screen will display and it looks just like the normal Surface
Measurement interface.

3.2 MP10 Grating Motion

In the Options window (Figure 3.2), there is a new parameter, Home Return
Distance, for homing the projection grating stage when the program starts. This
parameter defines the homing position of the grating stage along its 12 mm travel
distance. It is set to an optimal value by Akrometrix but can be adjusted by the user.

Options
B Acquisition |

Algorthm Random Shift

Delay Per Step (ms) 150

Surface Units mils
B Grating Motion

Backlash Distance {mm) 0.25

Home Retum Distance {mm) 6.75

Position Units mils
B Window Management

CloseAllWindowsOnAcquire True

FullFieldCompositeWindow False

PhaseWindow True

SurfaceWindow True

QK ] [ Cancel

Figure 3.2 MP10 Options Dialog

3.2.1 MP10 Grating Position

An MP10 Grating Position window (Figure 3.3) is added to the software to control
the position of the projection grating stage. It can be accessed from the menu item
Window->MP10 Grating Position.

1. In this window, the current position of the grating stage is displayed in
millimeters. Each time the program starts, this number will be initialized as the
value set for Home Return Distance item in the Options window (Figure 3.2).

2. Use the Jog Near and Jog Far buttons to move the grating laterally on the
sample surface, if necessary. It is not recommended to move the grating stage
significantly away from its home position. Operation of the translation stage near
either end of its 12-mm travel range can cause the actuator to stop moving if one
of the limit switches is reached.

Note: If the system is in E-Stop, the Jog buttons will
-| operate while the Motion Enabled button is pressed and
held.

Il

|
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3. The Absolute/Relative option allows the Position indicator to display either the
grating’s absolute position with respect to one end of travel or the relative
distance the grating has moved. The relative position is initialized to zero each
time Relative or Reset to Zero is clicked.

MP10 Grating Po..| |

Jog Far

Jog Mear

Position |milimeters)

6.75000

{(*) Absolute
() Relative

Figure 3.3 MP10 Grating Position Adjust Window

3.3 Calibration

Akrometrix believes that calibration should be performed whenever:
e The MP10 system is initially installed
e A new grating is used for the first time
e Individual optical components, such as the projection lens, or video camera
have moved

3.3.1 Calibration Parameters

The primary calibration parameter is the Fringe Value, defined as the change in
surface height represented by the lateral movement of one complete projected fringe
with respect to that of the reference plane (see Akrometrix Optical Techniques and
Analyses 101). Each calibrated grating has a unique Fringe Value, which is saved with
each measurement result and can be loaded during analysis.

A secondary calibration parameter is the Reference Plane, defined as an
unwrapped phase matrix of a flat surface. This matrix is also unique for each calibrated
grating. During measurement, the Reference Plane will be cropped according to the
Region of Interest (ROI) defined for measurement. The cropped reference plane matrix
is stored together with each phase image for data analysis. Displacement values are
then calculated from the phase image by subtracting the Reference Plane and
multiplying by the Fringe Value.
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3.3.2 Reference Plane and Calibration Block

To calibrate the MP10 system, a flat reference plane and a calibration block with a
known-size step are needed (Figure 3.4). The reference plane is a steel block with a
diffuse white flat top surface. The calibration block is a NIST-traceable steel block with a
step machined on its top surface.

&

Note: Never touch the top surface of either block.
Doing so could leave fingerprints or scratches on the
surfaces and result in rust or measurement errors.
Carry the blocks by their edges.

il

Figure 3.4 Reference Plane and Calibration Blocks

The reference plane is measured first and stored as a base for the next step. The
calibration block is then measured and the height of the points within the two large
planar step areas relative to the reference plane is calculated. Next, the software fits the
points within each area to an ideal best-fit plane, and calculates the offset between the
two planes. This offset is compared with the known step height. As a result, a new
Fringe Value is derived and a new Reference Plane Matrix is generated based on the
new Fringe Value. Both of the calibrated parameters will be stored or updated by the
software.

3.3.3 Software Operation

1. To calibrate the grating, click the small arrow to the right of the Grating
information area on the information bar. Select Calibrate... to open a calibration
wizard as shown in Figure 3.5. This is a 3-step wizard for MP10 calibration.

MP10 Calibration Wizard (Step 1/3)

Measure the reference sample and press NEXT when finished, @

Cancel

Figure 3.5 MP10 Calibration Wizard

2. In step 1 of the wizard, the reference plane is measured. Place the reference
plane in the center of the oven chamber under the camera view. Use the Sample
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Height Adjust window (see Figure 2.2) to focus the sample surface in the
camera view. Once the sample is in focus, move the sample along its plane so
that the projected area is approximately located in the center of the reference
plane surface.

3. Turn the light source up to its maximum intensity and adjust the iris ring of the
projection lens to achieve the best Depth of Field (DOF) and contrast for the
fringe image. Closing the iris will increase the DOF but reduce the brightness of
the image. The user should make sure to achieve optimal contrast across the full
camera view. Use the highlight pixels options in the Camera Control window to
avoid getting saturated or dark values in the fringe image.

&

___ Note: Do not adjust other parts of the MP10 system
such as the camera focus ring or stage and the
distance between each individual component. Doing so
will require a recalibration.

—_—

4. After an optimal fringe image is achieved, right click on the image and select
Acquire... (or F12). A phase image and 3D plot of the reference plane appear on
the screen. Verify the quality of the displayed results. A good phase image
should show smooth gradients from black to white within each fringe. Be sure
areas around the edges aren’t noisy; this may indicate insufficient contrast (see
Figure 3.6 and Figure 3.7). The 3D plot should also look smooth and show no
noisy or empty areas. Press Next in the wizard window if the displayed data is
satisfactory. Otherwise, adjust the settings and acquire another image.

N

Figure 3.6 Good Phase Image Figure 3.7 Bad Phase Image

5. Enter the cal block Offset Height value in the next window and click OK (Figure
3.8). This value can be found on the Calibration Certificate provided with each
block (Figure 3.9).
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Calibrate Fringe Value s
+ N———
APPLIED TECHNICAL SERVICES, INCORPORATED
Cattration Data Sheet
Enter the Offset Height from the Calibration Block certificate:
AT ame e aetuse  Outwme e
Offset Height inches) e o e . » ..
. vae  ATH.04 e - "
000276 (2]
-
- - - a - - -
-———- - -~ -
[ R CUSTOMER AS FOUND A0 DR
e e RANGE INSTRUMENT | TOLERANCE READING .-
Flgu re 3.8 Offset Value Dlalog Distance 0.0030" +-0.0005 | € 000276" D T S -
Flatness Upper 0.0000" +/-0.0002" 0.00008" -
Flatness Lower 0.0000" +/-0.0002" 0.00017"
F 0.0000" +/-0.0002" 0.00019"

Figure 3.9 Offset Value from Certificate

6. In step 2 of the wizard, the calibration block is measured. Remove the reference
plane from the oven and place it back in its box. Place the calibration block in the
oven where the reference plane was located and orient the block such that the
step line runs from left to right. The serial number engraved on the edge should
face the user (Figure 3.10). The thickness of the calibration block and the
reference plane are designed to be same. Therefore, the surface should be in
focus. If not, slightly adjust the sample stage up or down using the Sample
Height Adjust window (see Figure 2.2).

Figure 3.10 Calibration Block in the Oven

7. In this step, a large rectangle with two inner rectangles is shown on the screen.
The two small rectangles define the two surface areas used to calculate the step
height. Move the sample along its plane so that the intermediate step line is
between the two inner rectangles (Figure 3.11). Exact alignment is not required
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because the calculation is only based on the inner two rectangles. Adjust the iris
ring of the projection lens to achieve optimal fringe contrast.

Figure 3.11 Calibration Block Image

8. Right click on the image and select Acquire... (or F12). A phase image and 3D
plot of the calibration block appear on the screen. Verify the quality of the
displayed result as in step 4. Press NEXT in the wizard window if the displayed
data is satisfactory. Otherwise adjust the settings and acquire another image.

9. In step 3 of the wizard, a series of parameters appears in the wizard window:

a.
b
C.
d. New calibrated value that would adjust the measurement to the correct

Actual step height input by the user

. Step height calculated using the current calibration value

Current fringe value before calibration

calibrated value.

If the calibrated fringe value has less than +10% variation from the previous
calibrated value, press Next to approve. If an error is suspected (refer to Section
3.3.4), press Cancel to discard the new calibration value. On the next page, press
Finish to end the calibration procedure. The software will switch from the calibration
mode to measurement mode automatically.

10. After calibration, the Fringe Value is added for the new grating or updated for the
existing grating. This can be verified by clicking the small arrow to the right of the
Grating information area on the information bar and selecting Edit Parameters...
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(see Figure 3.12). The Reference Plane is also stored in memory and on the
hard drive.

Calibrate...

Edit Parameters...

Gran'ng: 168um ~| Camera Iris: 99% | Phase Amplitude: 3 | ROI Location: 423, 256 Size: 581, 604

Figure 3.12 Edit Grating Parameters
11. Remove the calibration block from the oven and store it in its box.

3.3.4 Troubleshooting Calibration
Problems
Calibration value varies more than £10% from the previous calibrated value.
Solutions
1. Check that correct grating was selected by clicking on the grating bar located at
the bottom left of the information bar. A Select Grating window pops up showing

a list of gratings added to the system. The desired grating should be highlighted
(see Figure 3.13).

-

=,

Select Grating
Pitch {um) Seral Mumber  DAQ Fringe Height fum)  Fringe Value {um)
a4 12345 a4 14554
168 20081002 168 3117606
168 REh 168 25588
QK l [ Cancel

Figure 3.13 Select Grating Window

2. Check sample set-up

a. Check sample height. Sample surface should be in focus.
b. Check sample brightness. Sample surface should not be entirely black or

saturated white

Problems with set-up are usually easy to observe in the phase image. A good

phase image shows one or more smooth gradients from

black to white within each

30-50SW-0002 Rev. A
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fringe. Random noise, monotone gray, or strong black and gray bands within the phase
image are indicators of improper setup.

3. If individual optical components have been moved, the optical system needs to
be re-aligned before calibration. Refer to the MP10 Module User Manual.

4. If the camera height or focus ring is changed, the system FOV (Field of View) or
magnification will be changed. In this situation, it is possible to obtain a variation
of more than 10% on calibration value even if the optical system is re-aligned.
Consult with Akrometrix for validation of the system.
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4 DIC Surface Measurement

The interface and operation of the DIC Surface Measurement program are very
similar to the Surface Measurement program. A user unfamiliar with the Surface
Measurement software should read Section 2 first or refer to it where necessary for
operation of the DIC software. In this section, only DIC specific functions will be
described.

Because the DIC technique is fairly different than that of shadow moiré or fringe
projection, the program interface is much simpler than for those techniques. No analysis
or calibration functions exist in this software. The only major function available is to
acquire images from both cameras simultaneously.

Note: The AXP sample height adjustment stage is still
~| inuse. Instead of executing phase shifting, it is used to
move the sample vertically for focusing purposes.

Il

|

4.1 Start-up
1. Remove the TherMoiré grating from the oven lid if it is in place.
2. Install the DIC module. (Refer to the DIC Module User Manual).

3. Run the DIC Surface Measurement program by clicking the corresponding
button on the Akrometrix Studio Manager toolbar on the left side of the screen. A
start-up splash screen appears while the software initializes.

4. When the Homing Sequence Confirmation Dialog is displayed (Figure 4.1),
press Yes to continue program initialization. The TherMoiré sample support
stage will home.

Yakrometrix

DIC SURFACE MEASUREMENT

Homing Sequence Confirmation

o Sample support will home to bottom of travel and
~.._"]/‘ return to the current pasition. Continue?

l fes l [ Mo ]

Figure 4.1 Homing Sequence Confirmation
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5. The main screen will display and it looks very similar to the normal Surface
Measurement interface, except that it has two camera views instead of one
(Figure 4.2).

[[** 0i€ Surface Measurement BB
e Tods wedw tep

Figure 4.2 DIC Surface Measurement

6. Right-click anywhere in the Camera window to Acquire data or change the
camera zoom factor.
4.2 Software Options

A simplified options dialog (see Figure 4.3) is available in Tools->Options, just as
in normal Surface Measurement. There are no new options. The only difference with
respect to normal Surface Measurement is that options that do not apply have been

removed.
-\

Position Units mils

EH Window Management
Close AllWindowsOnAcquire False

0K || Canesl

Figure 4.3 DIC Options Dialog
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4.3 System Calibration

Calibration of the stereo system requires capturing 15-20 images of a calibration
target in different rotations for each image. This is accomplished by the following
procedure:

1. Setup the DIC system as described in the DIC User Manual.
2. Position the calibration target underneath the cameras’ FOV.

3. Capture an image of the calibration target, then rotate the target. Repeat 15-20
times and then save the images.
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5 Troubleshooting

5.1 Troubleshooting Data Acquisition

As with any measurement system, the AXP has its limitations. These limitations
exist because the shadow moiré technique with phase stepping analysis is sensitive to
the optical properties of the samples measured. The optical and analytical limitations of
the system include:

¢ Failure to obtain good fringe phase information.
e Loss of resolution on samples with a wide range of reflectivity.
5.1.1 Failure to Obtain Quality Phase Information

Phase information is obtained for each pixel in an image by combining four images
on a pixel-by-pixel basis. In general, quality phase information can be obtained
anywhere good fringe contrast is observed in the raw video image. Frequently, good
phase information can be calculated even where the human eye cannot resolve fringes;
for example, against a permanent background pattern such as circuit traces. However,
there are situations where quality fringes cannot be obtained:

Symptoms:
¢ An extremely noisy grayscale signal appears in the phase image. (Figure 5.1)

e A banding pattern of grayscale values appears in the phase image.(Figure 5.2)

¢ Discontinuities exist in the calculated displacement data. (Figure 5.3)

h

Max - Min= 417 micrors

Figure 5.1 Noisy Phase Figure 5.2 Banded Phase Image Figure 5.3 Discontinuity Errors in
Image Displacement Data

Cause: Discontinuous Sample

Fringes are not generated at holes and cutouts or where the sample surface is
shadowed by components or other obstructions; fringes can only appear on the sample
surface itself. While these are obvious statements, the problems resulting from
nonsense phase calculations within such localized regions frequently cause incorrect
interpretation of the phase image.

Surfaces with abrupt discontinuities, such as steps, components, or solder balls,
can create analysis errors characterized by sharp diagonal edges in the calculated
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displacement surface (Figure 5.3). For shadow moiré, abrupt implies adjacent pixels
with a height difference greater than half the fringe value, e.g. greater than 0.005”
(0.127 mm) for a 100 line per inch grating or 0.0017” (0.043 mm) for a 300 Ipi grating.

Solution:

a. Use the Phase Amplitude option with an appropriate threshold value to
automatically eliminate bad pixels from the phase image.

b. Use a grating with a larger pitch, e.g. a 100 Ipi grating instead of a 300 Ipi.

c. Apply a user-defined mask over holes and slots using Surface Analysis. See
the Surface Analysis User Manual for more details.

d. Within the Surface Analysis program, vary the filter conditions.
Cause: Incorrect Phase Step Distance

An incorrectly assigned phase step size results in the incorrect calculation of
phases. This is due to incorrect software grating selection, incorrect calibration values,
or physical contact between the sample and the grating. If the sample support frame is
raised so that the sample is touching the grating, the sample is not uniformly translated
relative to the grating during the phase stepping data acquisition.

The grating is touching the sample (more generally, some point on the lid is
touching some point on the sample support fixture), so that the grating does not
translate independently of the sample during phase stepping. The phase image
frequently has the appearance of Figure 5.2. Use the Sample/Grating Height
adjustment dialog to manually raise and lower the sample at Slow Speed. If the sample
is touching, the fringe pattern is frozen at some or all points on the sample.

Solution:
a. Lower the sample, or raise the grating, so that they are not touching.

b. Check to make sure the correct grating is selected from the drop down list in
the software.

c. Open the calibration file and check that the grating value is within £10% of the
theoretical value. If not, perform calibration.

Cause: Sample-Grating Distance

A fringe pattern is not visible when the distance between the sample surface and
the grating is too large. There is an effective working distance below the grating within
which fringes on the sample surface can be observed. The shadow of the grating loses
sharpness as the distance from the grating increases due to diffraction effects and finite
thickness of the light source. As a rule of thumb, these distances are approximately:

e 0.8in (20 mm) for the 50 Ipi grating

e 0.2in (5 mm) for the 100 Ipi grating, and
e 0.02in (0.5 mm) for the 300 Ipi grating.
Solution:
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Adjust the height of the sample, either with the servomotor stages or by changing
the sample support fixture. Position the sample so that it shows a high contrast fringe
pattern on the raw video feed, but is not touching. If the sample is translated from this
point using the servomotor stages, the user observes that the fringe pattern moves
smoothly and uniformly across the sample. If some part of the fringe pattern does not
move during translation, this usually indicates that that part of the sample is touching
the grating.

In some cases, it may not be possible to bring the sample surface within working
distance of the grating, e.g. with a tall component or connector on the sample surface.
Approaches Akrometrix has used under these circumstances include:

¢ Inverting the sample and measuring the back surface, or
e Using a lower resolution grating with a larger working distance.
Cause: Unfavorable Surface Optical Properties

The surface has unfavorable optical properties. Shadow moiré is based on diffuse
reflection from the sample surface, which allows the interference patterns between the
shadow grating and the reference grating to be observed. Surfaces that provide poor
diffuse reflection include:

e transparent surfaces, such as glass

e specular reflecting surfaces, such as polished metal or solder pads
e Dblack or other dark-colored surfaces

Solution:

a. Using the Phase Amplitude option with an appropriate threshold value
automatically masks regions with such unfavorable optical properties,
excluding these bad pixels from the phase image and subsequently the
analysis calculation.

b. Painting the sample with a thin coat of high temperature white paint provides
optimal surface properties for shadow moiré without significantly affecting
mechanical properties. Other surface treatment methods may be used,
depending on the sample, including creating a matte finish on a metal surface
by etching or abrasion.

c. Blurring the focus of the camera can help in some circumstances. For
example, blurring allows a strong fringe signal from the terminal ring around a
through-hole to combine with the weak fringe signal from adjacent regions of
solder mask. This technique does reduce the lateral resolution of the
measurement.

Cause: Stray Sample Illumination

lllumination of the sample by any light other than the linear fiber optic light source
decreases the shadow contrast. In addition to ambient light, frequent sources of
additional light are reflections inside the sample chamber and light from the infrared
heating source.
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Solution:
a. Close system doors & turn off room lights.

b. Shield off as much of the heater light as possible by laying black paper or
cloth shields on top of the oven window.

c. Make sure that the IR filter is in place on the camera lens. In extreme cases,
shield off as much of the heater light as possible by laying black metal, paper
or cloth shields on top of the oven window.

5.1.2 Additional Sources of Error

Several second-order effects have been observed in phase-stepped shadow moiré
measurements that can affect results, particularly for extremely small and/or flat
samples. Periodic structures in the apparatus or samples can introduce corresponding
periodic errors in the phase image. In addition, the phase calculation algorithms inside
Akrometrix software can introduce small periodic errors.

High magnification of the sample can cause the grating lines themselves to be
resolved, which can cause a periodic error in the phase calculation. Choose a
combination of magnification and grating frequency so that the lateral resolution is at
least one full grating pitch. The general guidelines below minimize this problem:

1. If the full field of view of the video image is less than 160 mm in width, use a 100
Ipi or higher grating.

2. If the full field of view of the video image is less than 60 mm in width, use a 300
Ipi or higher grating.

Even when these guidelines are used, interference between camera pixel
spacing and grating line spacing can produce aliasing in the video image. This initially
appears as low contrast vertical (or near vertical) fringes across the image that vary in
pitch and rotation as the zoom lens magnification is varied. This effect can be minimized
by varying the lens magnification.

Interference between a periodic structure on the sample surface (e.g. a field of
solder pads on a BGA substrate) and the grating line spacing can introduce a periodic
phase calculation error. This effect can generally be observed by eye in the live video
image of the sample and may be eliminated by re-orienting the sample or changing the
grating (e.g. from 100 Ipi to 300 Ipi).

A second problem related not to system hardware, but to system software is
caused by the breakdown of the sinusoidal approximation used in the phase calculation
(see Akrometrix Techniques and Analysis 101). This appears as a series of ripples
superimposed on the final displacement results. The ripples are characteristically
parallel to the fringes appearing in the shadow moiré fringe pattern, but at four times the
fringe frequency (a similar effect occurs when an incorrect step height is used, but the
frequency of ripples is two times the fringe frequency).

In general, the amplitude of the ripples is comparable to the resolution of the system
and the effect on accuracy is within the system specification. However, saturation of the
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video camera by regions of high reflectivity can enhance this effect to higher levels. If
observed, this effect may be reduced through elimination of camera saturation by
closing the lens iris or reducing light source power. In some cases, the effect may also
be reduced by slightly increasing the distance between sample and grating. Consult
with Akrometrix technical support if this effect is creating significant measurement
problems.

5.1.3 Loss of Contrast and Resolution

A more subtle concern in making phase-stepped shadow moiré measurements
deals with the relationship between the digital resolution of the intensity measurements
and the precision of the vertical displacement data. The high resolution of the phase
stepping method is based on the number of grayscale levels available when the fringe
pattern is digitized. Using an 8-bit digitizer, there are 256 grayscale levels to encompass
the fringe pattern from its brightest to darkest pixel. These 256 levels directly relate to
the claim that vertical height measurement resolution is 100 times better than the
grating pitch. If there are fewer levels available for digitization, the measurement
resolution is proportionately reduced.

The manual lens iris should be adjusted so that maximum sample brightness is
just below the saturation level of the digitizer. This is generally sufficient when the
illumination and diffuse reflectivity of the surface is uniform across the sample.
However, when the sample contains regions of high and low reflectivity, the fringe
intensity signals from the two regions each cover only a small amplitude at the extreme
high and low ends of the digitization range. In order to encompass both the dark fringe
pixels in the low reflectivity region and the bright fringe pixels in the high reflectivity
regions, each of the two signals spans a smaller range of digitization levels and the
vertical displacement resolution in each region is reduced.

Painting the surface is the simplest procedure to eliminate this problem. If the
surface cannot be painted, useful phase and displacement information can still be
obtained for many samples, but the resulting loss of precision should be kept in mind.
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Appendix A - Miscellaneous Information
A.1 File Formats

Akrometrix Surface Measurement saves data in a format with extension
.akx_phase. These files should automatically be associated and can only be opened
with the Surface Analysis application. Other image file formats can be exported from the
program but cannot be loaded back into any Akrometrix software. Image export formats
include: .bmp, .gif, .jpg, .png, and tif.

A.2 Keyboard Shortcuts

F3 Toggle Fill ROI behavior

F5 Bring Camera Window to foreground (will not hide Camera Window)
F6 Show/Hide Sample Height Window

F7 Show/Hide Camera Control Window

F12 Perform an Acquire (capture data)

Ctrl+T Open Thermal Profiler application

Ctrl+S Save as *.akx_*

Ctrl+l Save as image

Ctrl+W | Close

Ctrl+O  Open in Surface Analysis

While the ROI has focus the following keyboard shortcuts apply:
Ctrl+5 make ROI its maximum size.

Alt+5 make ROI half of maximum size and position in center of field of view.
Up Arrow or 8 on NumPad Move ROI up one pixel

Down Arrow or 2 on NumPad Move ROI down one pixel

Left Arrow or 4 on NumPad Move ROI left one pixel

Right Arrow or 6 on NumPad Move ROI right one pixel

1 on NumPad Move ROI down one pixel and left one pixel
3 on NumPad Move ROI down one pixel and right one pixel
7 on NumPad Move ROI up one pixel and left one pixel

9 on NumPad Move ROI up one pixel and right one pixel

Ctrl plus any of the above will increase the ROI size in the desired direction.

Alt plus any of the above will decrease the ROI size in the desired direction.
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